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When discussing the use of technology with foreign language 
instructors who do not use Internet technologies in their teaching, 
two questions are often asked- "why'' and "how'~. Some are not cer
tain why the web should be used at all. Others are interested in tak
ing advantage of the Internet, but have not had the time or funds to 
learn how .. What follows is an attempt to answer both questions, by 
proposing a multiple format approach to vocabulary acquisition 
that is ideal for an on-line environment, and by providing step-by
step instructions for creating the web pages. The article begins with 
a brief overview of research in second language vocabulary acquisi
tion that suggests three ways to present vocabulary: contextually, 
grammatically/alphabetically and thematically. The advantages of 
placing these formats on the web are discussed in the next section, 
which also includes instructions showing how teachers with no pre
vious web design experience can quickly and easily transform the 
formats into web pages and add simple yet effective features such as 
links and images. These instructions are for Microsoft Word or Corel 
WordPerfect, word processing programs with which most instructors 
are already familiar. For instructors with some experience in creat
ing web pages, more elaborate web features that can further enhance 
vocabulary learning are also mentioned. 

Many teachers encourage the use of"top-down" vocabulary learning 
strategies where, as is the case for most lexical knowledge acquired 
in one's mother tongue, surrounding words and ideas with which 
the person is familiar can help clarify a confusing term or concept 
(Bernhardt, 1991, p. 176). This has led to presenting vocabulary 
"contextually'~ in the form of reading passages or written dialogues 
(such as the example in Appendix I) which in some cases has proven 
quite effective (see Huckin, Haynes & Coady, 1993). Yet this is not 
the case for all learners. Research shows, for instance, that good 
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readers actually depend less on context to acquire vocabulary, in 
part because their more developed lexicon leads to greater semantic 
certainty (Urquhart & Weir, 1998, p. 42). For other learners, espe
cially beginners, context can be misleading and the lack of precise 
information in many "authentic, texts can lead to erroneous 
assumptions concerning meaning (Singleton, 2002, p. 193; Folse, 
2004, p. 77). In other cases, when context is too clear or too familiar, 
some students who comprehend the gist of a passage simply do not 
attempt to understand the word or expression in question. This does 
not mean that a contextually-based presentation of vocabulary can
not be effective, but it is clearly not always the best solution for all 
students.i 

Another approach is to provide students with lists of isolated indi
vidual words and word forms. This is in keeping with the "bottom
up, theory of reading which posits that learners focus first on letters 
and words before attending to meaning at the sentence or paragraph 
level and beyond .. Presenting words organized according to form 
(prefixes, suffixes, verbs, nouns etc), as old fashioned as it may seem, 
is supported by research demonstrating how some L2 learners tend 
to focus on graphemic features and "non-contextual word analysis, 
(Haynes, 1993; Nation, 2001, p. 263; see also Folse, 2004, p. 39). It is 
also the result of practical considerations so that students may receive 
relatively rapid initial exposure to appropriate vocabulary in prepa
ration for activities that will demand they put their new knowledge 
into practice. In addition, it responds to the learning strategies of 
those students who are- and they still exist- rote learners, preferring 
to memorize lists, especially as a way to review lexical knowledge. 
One format that would correspond to such a learning strategy would 
be grammatical. An example is provided in Appendix II, with the 
added characteristic of alphabetical ordering as a convenient yet 
non-contextual means of organizing the vocabulary. This also has the 
advantage of grouping terms with similar prefixes (and, when articles 
are used, gender). 

In many cases, of course, students use an "interactive, approach that 
depends on multiple strategies- "bottom-up, in some cases, "top
down, in others (Rumelhart, 1977; Barnett, 1989; Huclcin, Haynes & 
Coady, 1993). One format that responds to this combined approach 
is semantic or thematic groupings where related words and expres
sions are presented together. Limited context is created by virtue of 
the thematic or semantic categories or subcategories, but vocabulary 
is still more isolated (and thus, for some, easier to retain) than in a 
complete dialogue or text (see Appendix III). This format also helps 
promote what Singleton calls "a natural part of the process of 
acquiring vocabulary, (Singleton, 2002, p. 192). Students may rec-
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ognize at least some of the semantically similar words found togeth
er, and then "make links between new words they encounter in their 
target language and words they already know:' Another type of 
interactive approach supported by research (Nation, 2001, p. 238) 
involves encouraging students to study more than one format. For 
instance, they could consult one version, such as a contextualized 
format, for initial exposure, then review with another, such as the 
decontextualized grammatical list. 

Research thus suggests that several different formats be made avail
able to students. While teachers often present vocabulary differently 
for different activities, it is rare that two or three versions of the 
same glossary be provided for the same activity. Yet multiple format 
vocabulary units in the form of web pages are surprisingly simple to 
create, and offer advantages for both students and instructors. 

One could attempt to assemble a collection of multiple-format 
vocabulary units in print form. But as the collection grows, it would 
become increasingly impractical to print and distribute large num
bers of pages each semester. It could also be unnecessary (and cost
ly) for students whose learning strategies are best served by only one 
or two of the formats. Furthermore, on-line versions ensure that 
students will always have access to, and will never lose, the vocabu
lary materials. Instructors will also appreciate the ease with which 
additions and modifications can be made without having to photo
copy and redistribute new lists. Perhaps more importantly, there are 
several simple web features which can be added to Internet-based 
materials that enhance learning. External links, for example, can give 
students immediate access to important Internet resources such as 
on-line L2-L2 and L2-Ll dictionaries (a brief list is given in 
Appendix IV). Internal links, where each format contains links to 
the other two, allow for rapid navigation between the different ver
sions. This is an important consideration when attempting to 
accommodate the diverse learning strategies used by our students as 
it provides them with immediate access to the format or formats 
that best meet their needs. Other useful means of promoting vocab
ulary acquisition are mentioned below, including images which, as 
we shall see, even teachers with no previous experience in web 
design can quickly add to their vocabulary units. 

The three formats described in this article have been used for over 
six years in an intermediate level university French class. The exam
ples in Appendices I, II and III are used simultaneously with a vari
ety of activities relating to "the movies." These have included not 
only reading exercises, but also discussions about students' own 
experiences, improvised role-playing, listening comprehension, 
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compositions, and structured questions and answers. For each activ
ity, vocabulary is presented ahead of time and/or reviewed after
wards using all three formats. Since the three versions contain the 
same vocabulary, students are free to select the one that best corre
sponds to their learning style. 

Based on anonymous student evaluations of this approach, many 
choose to first study the thematic format because it contains more 
context than the grammatical/alphabetical version yet is "faster to 
read" than the contextual passage. Perhaps not surprisingly, some 
students, most notably those with a strong interest in theater, often 
opt to first work with contextual dialogues. In most cases, students 
have written that they review with the two remaining formats, espe
cially the grammatical/alphabetical pages. Interestingly, a number of 
more scientifically oriented students have used solely the grammati
cal/alphabetical versions for both initial study and review. As expect
ed, no single format has been preferred by all students but all formats 
are used by at least some, demonstrating the significant advantage of 
offering a selection of three for each activity. 

While most instructors may currently have only one version of a 
glossary they already use with students for a particular activity, it is 
worth noting that new formats can often be made in little time. 
Creating a thematic or grammatical unit from key vocabulary in a 
reading passage involves little more than cutting and pasting, or 
retyping, words and expressions into a new document. A list in 
alphabetical order can be quickly made using the sorting option in 
Word or WordPerfect .. (Detailed sorting instructions are provided in 

note 2.ii) For lists that include definite and indefinite articles, the 
sorting function also greatly facilitates the organization of gram
matical formats by automatically grouping all nouns. Given that the 
creation of a contextual unit may require more substantial effort, 
instructors who do not already have appropriate texts may wish to 
focus first on the other two formats. This said, readers should keep 
in mind that contextual glossaries can serve not only as preparation 
or review for other activities, but as activities themselves - such as 
reading comprehension or, in the case of dialogues, scripts for role
playing. 
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What follows is a step by step explanation of how to create web
based versions of the three formats mentioned above using 
Microsoft Word or Corel WordPerfect. 

1) Converting a current document into a web pageiii. 
(Time needed to complete: 1 minute!) 

WORD-
( Instructions for Word on Macs will be provided separately 
when necessary.) 
(Users of Corel WordPerfect see below.) 

a. Open the document in Word. 
b. Go to File and choose "Save as Web Page ... '' (or, for 

older versions of Word, "Save As ... ") 
c. Name your file. [Mac: CAREFUL- do not delete the 

.htm extension in the file name.] 
d. Next to "Save as type:" [Mac: "Format"] select "Web 

Page (*.htm, *.html)" if necessary. 
e. Select (or create) the folder in which you will save all 

your web pages. 
f. If necessary, add or change the title that will appear at 

the top of the browser window when students view your 
web page by clicking on Change Title, typing the new 
title and clicking on OK. (Mac: Select "Web Options'~ 
then "Web page title'~ change title and click OK.] 

g. Click Save. 

WORD PERFECT-
a. Open the document in WordPerfect. 
b. Go to File and choose Publish to HTML. 
c. Name your file. 
d. Click on the small rectangular document icon at the 

end of the "HTML File Name" text box. 
e. Select (or create) the folder in which you will save all 

your web pages., then click Open. 
f. Click Publish. 
g. If necessary, add or change the title that will appear at 

the top of the browser window when students view 
your web page by going to the File menu, selecting 
Properties, the Summary tab, and typing a new title 
next to "Descriptive name:'~ Click OK. 

Word and WordPerfect also provide an option to include links, 
which can further enhance the glossaries. While more advanced fea
tures such as links that call up definitions in a separate window are 
mentioned later in this article, two types of links can be easily added 
by any instructor: links to on-line dictionaries, and links that allow 
easy navigation among the different formats. 
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2) Adding links to external sites (on-line dictionaries). 
(5 minutes) 
There are a variety of useful resources for on-line vocabulary mate
rials, a number of which are included in Appendix IY. If possible, it 
is helpful to include links to at least two dictionaries, such as one L2-
L2 and one L2-Ll.iv This gives students a choice, and increases the 
chances that at least one dictionary will be available when students 
are on-line.v 

a. Open your glossary (in Word or WordPerfect). 
b. Type the names of each dictionary near the top of the page, 

perhaps just under the title of the glossary. 
c. Highlight the dictionary name (in the examples, "Le Tresor 

de Ia Langue Francraise informatise"). 
d. Open the link properties window as explained below: 

WORD-
Go to the Insert menu and choose "Hyperlink'~ Make 
sure the box "Existing File or Web Page" on the left is 
highlighted. 

WORD PERFECT-
Go to the Tools menu and choose "Hyperlink': 

e. Add the URL (web address) 
In the text box for your "Address" in Word (Mac: "Link 
to"), or next to "Document/Macro:" in WordPerfect, you 
should type the complete dictionary URL (in this case: 
"http://atilf.atilf.fr/tlf.htm") 

f. Next, you should add a setting that will make the link open 
in a new window (so the vocabulary window does not disap
pear when students click to access the dictionary). To do so: 

WORD-
Click on "Target Frame" and choose "New Window" 
from the drop down menu. (Mac: This option is not 
available in all Mac versions of Word. For a 
workaround, see note 6.vi) 

WORD PERFECT-
In the text box after "Target Frame': type 
"newWindow': 

g. Click OK to create your link. 
h. Repeat steps c through g, this time highlighting the second 

dictionary (here: "WordReference.com") and using the URL 
(here: "http://fr.wordreference.com/fr/"). 
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3) Linking the three formats together. ( 15 minutes) 
In order to facilitate navigation among all the formats, it is helpful 
to include links to each version on every page. This also allows the 
instructor to direct students to only one format knowing that they 
will be able to easily access the others if they choose. In addition, it 
encourages students to use more than one format. 

This step assumes you have already made three formats and saved 
them all in the same folder on your computer. If not, you should do 
so now before continuing. 

a. Open one of your vocabulary formats (in Word or 
WordPerfect). 

b. If you have not already done so, add the name of the format 
near the top of the page - perhaps just below the title ("LE 
CINEM~' in the examples) but above the two dictionary 
links. 

c. Type the names of all three formats, perhaps under the two 
dictionary links and after the word "formats:'~ For the three 
formats discussed here, "thematique", 
"grammatical/alphabetique" and "en contexte" have been 
chosen. 
So far, the top of your document might look like this: 

LECINEMA 
thematique 
WordReference.com Le Tresor de la Langue Franr;aise informatise 

formats: thematique grammatical/alphabetique en contexte 

d. In the "formats:" line with all three formats, highlight that 
of the page to which you would like to make a link, such as 
"en contexte'~ 

e. Open the link properties window as explained below: 
WORD-

Go to the Insert menu and choose "Hyper link'~ 
Make sure the box "Existing File or Web Page" on the 
left is highlighted. (Mac: click on the Document tab.) 

WORD PERFECT-
Go to the Tools menu and choose "Hyperlink'~ 

f. Add the URL (web address): 
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WORD-
i. While still in the Insert Hyperlink window, make 

certain that the box "Current folder" is highlighted. 
(Mac: Having clicked on the Document tab in the 
Insert Hyperlink window, click on the "Select .. :' but
ton.) 

ii. Look in the various folders on your computer until 
you find the one with your three vocabulary pages. 

iii. Select the "en contexte" page and click OK 
WORDPERFECT-

i. Click on the small rectangular document icon to the 
right of the first text box (just before the "Browse 
Web" button). 

ii. Look in the various folders on your computer until 
you find the one with your three vocabulary pages. 

iii. Select the "en contexte" page and click OK 

Note: Unlike the links for the two dictionaries, here you need not add 
a setting to make each page open in a new browser window because 
students generally only need to work with one format at a time. 

g. Click OK to create your link. 
h. Repeat steps d through g for the remaining link, in this case 

"grammatical/alphabetique': 
Note: when you transfer your glossary web pages to the Internet, you 
must be certain that they are all in the same folder 
(or directory) as they are on your computer. vii 

This above steps should take little more than five minutes to 
complete per web page, and might, for instance, look like this: 
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4) Editing a web page. (Time varies) 
Once you have created web pages for a vocabulary unit, it is very 
easy to edit and modify them. 

a. Open Word or WordPerfect, go to File, Open File and open 
the web page. 
(Do not click directly on the web page, or your browser will 
open.) 

b. Modify the page as you would any text document. 
You may also change or add more links as outlined in parts 
2 and 3 above. 
(Mac: Mac users may need to refer to note 6.) 

c. Save your modified version: 
WORD-

i. Go to the File menu and select Save. 
NOTE: When saving a document that is already a web page, Word 
will automatically set the document type as "Web Page': and pro
pose the same file name and location as the page you are editing. 

ii. If you wish to change the file name or location, 
select Save As. 

WORDPERFECT-
i. Each time you save a web page, you must select 

Publish to HTML (not Save). 
ii. Whether you wish to save the web page using the 

same or a new name, you must in both cases type 
the name and, if necessary, select the file location 
as explained in Step I e for WordPerfect. 

Following the instructions above, any teacher can thus easily create 
on-line versions of multiple format vocabulary units. These basic 
web pages can facilitate the organization, distribution and modifica
tion of glossaries. They can also promote vocabulary acquisition by 
providing students with multiple formats that are well-suited to 
their diverse learning strategies as well as direct access to useful on
line dictionaries. 
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There are of course many other web features that hold great poten
tial for on-line glossaries. The use of audio, a recording of the con
textual format for example, could help students learn proper pro
nunciation and intonation. It could also contribute to vocabulary 
acquisition for those learners who benefit from hearing rather than 
only reading texts. Video helps place vocabulary in context both 
aurally and visually. It can build on the advantages of audio by 
showing students physical aspects of communication (gestures, 
facial expressions etc.) as well as highlighting culturally salient ele
ments of, for instance, the setting where a particular speech act 
might take place. Some studies have even shown that video (with 
text) definitions are retained better than those consisting of still 
images (with text) or only text (Al-Seghayer, 2001; see also 
Omaggio-Hadley, 2001). 

Yet another web feature that can be applied to vocabulary instruc
tion is the use of forms. In a more advanced version of the multiple 
format pages presented above, for example, students have the option 
of calling up a small pop-up box (a layer) inside which is a form 
where they can type only the words they wish to study, add their 
email address, click and immediately send themselves a personalized 
list to review at a later date. A similar technique is used to allow stu
dents to see a definition when they place their mouse over a term: 

qfii"'CU!1ls•V•bh•btqz•t 

l !t:,.trJ!;AT)"I ,J,.t. ,tft!ot.i.t:9t:n ...... p..t:raftc,•~ot q,~,u .... t . .,~ .. ut r.ulll~~t.ll" ""~ '""uur ;;ur ~.f'rl"'ut~ 
c---~o~oto.e.a._.._. .. ....,...,.. ___ ~ 

Un lib.,.. .... pw -rn.a-

l•tousnqe 

te acftlario du &1m. 

La clistrihndau d•~~n rWa r.::::~~:~:::;:-E-:,.-;::::::::~~:.1 
le 6!m en •orti ~D 2003 
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Another use of forms has been proposed by Nagata ( 1999), who has 
demonstrated the effectiveness of providing students with multiple 
choice definitions that give automatic feedback in the event that the 
student makes an incorrect choice. This could be an interesting 
technique to apply to the contextual version: by clicking on the 
desired term, students would see a small pop-up window with a 
choice of two or three words and definitions. For each incorrect 
choice, an explanation would appear that could make direct refer
ence to the context of the passage. viii While preparing and embed
ding audio or video, creating forms, or including small pop-up win
dows is best done with specialized multimedia and web design pro
grams such as Front Page or Dreamweaver, ix there is still one useful 
web feature that any instructor can include in a web-based vocabu
lary page: images. 

As Omaggio Hadley has pointed out in her discussion of "visual 
organizers'~ and as studies have confirmed, definitions containing 
text and still images can be particularly effective in promoting 
vocabulary acquisition, especially at the beginning and intermediate 
levels (see Omaggio Hadley, 2001; Chun & Plass, 1996). The effec
tiveness of any feature, of course, depends on many factors such as 
student learning styles, learning context, and, especially, technical 
issues relating to the use of multimedia. Though less problematic 
than audio or video clips, images, if too large or too numerous, can 
significantly slow down the speed at which students can access a web 
page, particularly when using a dial-up modem. This can be avoid
ed by reducing image sizeX, limiting the number of images on one 
page, or, if one has access to web design software, by taking advan
tage of advanced features such as small pop-up windows so that 
only one image (ie. definition) needs be called up at any one time. 
Assuming, however, that the instructor has a small number of rea
sonably sized imagesxi, including them on a web page using Word or 
WordPerfect is quite simple. 

For users of these programs, it is easiest to include images directly 
on the thematic or grammatical/alphabetical formats (which are 
generally in list form) above or below the term or expression being 
defined. This can be done as follows: 
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5) Inserting Images. ( 1 or 2 minutes per image) 

a. Open the document with Word or WordPerfect. 
b. Drag the image directly from your computer (or directly 

from an open browser if using an image from an existing web 
site) onto your web page either before or after some text. If 
you have difficulty dragging an image onto your page (as is 
sometimes the case with WordPerfect) or if you would like 
more flexibility as to the location or appearance of your 
image on the page, see below. 

c. Be sure to include, perhaps at the bottom of the page or 
directly below the inserted image, the appropriate references 
for the source of your image if necessary. 

d. Save your web page as explained in Part 1 above. 

Note that when you save a web page with an image, a new folder is 
automatically created. If the web page is called "movies1.htm': the 
folder will be named "moviesl_files, in Word, "movies1, in 
WordPerfect, and will appear in the same location on your comput
er as the "moviesl.htm, file. This folder contains the image you have 
just added. It is important never to separate the folder and the page, 
and to transfer both to the web server when placing the web page 
on-line. Also, if you must change the file name, this can only be done 
by opening the page in Word or WordPerfect and saving it again with 
the new name (in which case, a new image folder will be created).xii 

TIPS: 
Alternative to dragging and dropping images: 

a. If you cannot or choose not to drag an image onto your web 
page, first save that image onto your computer (for images 
from a web site: right-click, "Save Image/Picture As,). 

b. Click once on your web page next to the word where you 
would like to insert the image: 

WORD-
In the Insert menu, choose Picture, then From File. 

WORD PERFECT-
In the Insert menu, choose Graphics, then From File. 
NOTE: When inserting an image, WordPerfect will 
automatically convert the image size to a width of 1.5 

inches. 
c. Select the desired image. 
d. Click OK. 
(See below for details on positioning images.) 
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Changing image size as it appears on the web page: 
Remember, this will not modify the actual file size of an image (see 
note 10). It is useful, however, for minor adjustments in appearance. 

WORD-
a. Double click on the image, or click once on the image, 

go to the Format menu and select Picture. 
b. In the Format Picture window choose the Size tab. 
c. Reset the size either by changing the height and width 

in inches or as a percentage of the original size. 
d. Click OK. 
OR 
a. Click once on the image. 
b. Place your mouse over any corner, click and drag to 

desired size. 
WORD PERFECT-

a. Right-dick on the image and select Size. 
b. Set the new size (in inches). 
c. Click OK. 
OR 
a. Click once inside the image. 
b. Place your mouse over any corner, click and drag to 

desired size. 

Setting the position of the image on a page: 
Both Word and WordPerfect allow for considerable flexibility when 
setting image location in relation to text. The easiest setting, howev
er, and one which is most useful for vocabulary lists, is having the 
image placed just above or just below the word or expression being 
defined. 

Text above [or below] an image: 
WORD-

a. Insert the image just after [or before] the word or expression 
being defined (as explained above in Part 5.) 

b. Place your cursor at the end of the word or expression, just 
before [or after] the image, and hit Return/Enter. 

Below is a screen shot of an image added below the word "mul
tiplexe" on the thematic format. 

WORD PERFECT-
a. Insert the image anywhere on the page. 
b. Right click on the image and select Wrap. 
c. Under "Wrapping type'' select "Neither side': 
d. Click OK. 
e. Right click again on the image and select Position. 
f. Next to "Attach box to:" select "Paragraph" from the drop 

down menu. 
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g. Click OK. 
h. Drag and d rop the image just above [or below] the word or 

expression being defined. 
Below is a screen shot of an image added below the word "multi
plexe" on the thematic format. 

·-~,.,_ .. __ ,__._,...... ... ,~----....... ,..... .... _l)o_ .. " 

... .__MIJ.f.,..,.,.._( ......... ,...,... ... , .......... _ ,_, 
u..,,....... .... --.... .. _,.... 
c...-.J-···-,.......- ........ ....... . 

LEFIW 

~~..._ ............. ,--c_, ........... ,_......._ 
'*'~~·----

As mentioned earlier, these instructions are useful for inserting 
images onto a page of vocabulary in list or short sentence form . 
Besides being the quickest approach, this helps avoid more complex 
technical issues of wrapping longer text around an image or trying 

to place an image in the center or on the right side of a page.riii 
Using fairly small images that load quickly and allow students to 
easily view both the text and image at the same time can be an effec
tive means of reinforcing the association between a term or expres
sion and a definition. 

Multiple-format web page glossaries linked together, lin ks to on-l ine 
resources, images: while only a few of the many features the Internet 
provides that can enhance vocabulary acquisition and language 
learning, these ca n be easily incorporated into a course by any 
teacher without the use of specialized web design software. The 
above suggestions will hopefully help those who have not yet done 
so to take advantage of the web - without getting caught in it. 
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NB: Examples of web pages and links to Word documents and sites mentioned 
in the article are available at http·llwww people fas harvard edu/-dbmarsb/iallt/ 

i This also suggests that passages containing vocabulary should be carefully 
selected and prepared. The simple fact that vocabulary appears in a text does 
not mean that context will be sufficient to allow the vocabulary to be under
stood or learned. At lower levels, for instance, a certain amount of repetition 
with slight modification, or reformulation, of expressions (which is not always 
present in an "authentic" text) may be necessary. Appendix I contains a con
textual dialogue in French that is designed to highlight certain words and 
expressions for intermediate level learners using both reformulation and italics. 

ii SORTING 
A grammatical/alphabetical format can be easily made using the Sort function in 
Word or WordPerfect, and then separating the words by grammatical category. 
"Sorting" is also a simple means of organizing by gender in languages that use arti
cles and will also automatically group together words with similar prefixes (revoir, 
revenir etc.). For those unfamiliar with sorting, you must first prepare your list. To do 
so, delete all vocabulary from a contextual or thematic glossary that will not be 
included in the grammatical/alphabetical list (such as all words in Appendix I that are 
not in italics). Place a carriage return (Enter) after each remaining word in order to 
make a horizontal list with only one word (or expressions) per line. Then: 

WORD- (PC and Mac) 
a. Select the entire list. 
b. Go to the Table menu and choose Sort. 
c. The options should read- Sort by: Paragraphs, 'IYPe: text , with the 

Ascending button highlighted. "No header row" 
should be selected after "My list has'~ 

d. Click OK 
e. Verify to make certain that the ordering is correct. 

WORD PERFECT-
a. Select the entire list. 
b. Go to the Tools menu and choose Sort. 
c. Next to "Sort by:'~ highlight "First word in a line." The "File to sort" and 

"Output to" options should both read 
"Current Document. (NOTE: If you prefer to sort in descending order (z to 

a), click on Edit, modify the "Sort 
order" and click OK. If you are uncertain and would like to ability to undo 

the sorting, be sure to click on Options 
and select "Allow Undo after sorting':) 

d. Click Sort. 
e. Verify that the ordering is correct. 

iii Once a web page is made, it needs to be placed on-line - transferred from the 
instructor's computer to a web server. In most cases, it will be necessary to contact a 
computer services administrator at your educational institution for information on 
how to "upload" a web page to the school server. For some institutions, this involves 
little more than a few clicks in a course management system such as Blackboard or 
WebCT. For those without a school server, free and low cost web site hosting servic
es (some of which are included with Cable or DSL Internet packages) are also avail
able, and provide for the easy transfer of flies. 

iv The examples in this article include the French-French "Tresor de Ia Langue 
Fran~aise informatise" and the French-English dictionary at 
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"WordReference.com", originally based on a HarperCollins dictionary. The for
mer is quite complete and provides access to those with both dial-up and high
speed Internet connections. The latter contains less detailed definitions but as 
it includes English and often contains helpful contextual information, it may be 
useful for lower level learners. For recommended on-line dictionaries and URLs 
in French, Spanish, Portuguese, German, Italian and English, see Appendix IV. 

v Including links to these dictionaries can be useful even for lists that already 
include definitions. This not only allows students to look up terms that may not 
be defined, or to seek out a more detailed definition if necessary, but it exposes 
them to two important resources that they may wish to use at later time. In addi
tion, many students even at more advanced levels often do not have access to a 
good French-French dictionary outside of a school library. 

vi Mac Users: It seems that some versions of Word for Mac do not include a 
button to set the 11Target Frame" (allowing the link to open in a new browser 
window} .. There is a solution, however. 
1} After having made ALL the links for your web page, go to File and choose 

Save As Web Page. 
2} Without exiting from the document you have just saved, now go to the 

View menu and select HTML Source. 
3} Using the Find function in the Edit menu (or Apple+F), search for the word 

or URL in the first link. 
4) Here is an example of what you would see for the phrase "Search here" as 

a link to google.fr: 
<a href="http://www.google.fr">Search here.<la> 

5) just after the" and before the>, add a space and the following: 
target=''_blank" .. The result will look like this: <a 
href="http://www.google.fr" target=" _blank">Search here. <Ia> 

NOTE - If adding the space automatically transforms the URL into a link (if it 
becomes blue and underlined), go to the Edit menu and choose Undo autofor
mat. 
6) Go to the View menu and select Exit HTML Source. 
7} You will be asked once or twice to save the document. Click OK each time. 
8) You have finished. Do NOT save the page again as a web page, or all the 

"target" code will be deleted. 
This means, however, that once you have added the- target=" _blank" -to all 
your links, you can no longer edit the page in Word. If you later find it neces
sary to modify something, the best solution is to open the page in a web edit
ing program such as the free program Nvu (available at 
http://www.nvu.com/index.html), choose Edit Page, make any changes and add 
new links. For new links in Nvu: highlight the phrase, go to Insert, then Link. 
Type the URL. Below, under "Target", check the box next to "Link is to be 
opened" (if you do not see this option, click on the "More Properties" button). 
Make sure the option "in a new window" is selected. Click OK. Save your page 
by going to File and choosing "Save." 

vii A few details about links: When you click on a link on the Internet, your 
browser automatically assumes that the new web page is located in the exact 
same place (in the same folder or "directory") as the page you are viewing. 
When this is not the case, the link must include all necessary information- the 
new server, the directory (or directories) in which the page is located on that 
server, and the name of the page. For instance, a complete URL such as 
"http://www.myuniversity.edu/french1 01/vocab/movieslmovies1.htm" tells a 
browser to "go to the server on the Internet called "www.myuniversity.edu", 
look inside the directory (or folder} called "french1 01 "; now look for a directo-
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ry called 11VOcab" inside which there will be another directory, 11movies", that 
contains a file called "moviesl.htm". This is the case, for instances, with the 
two dictionary links mentioned earlier. If, however, all pages are in the same 
directory on the same server, such as the three formats, you would create a so
called 11relative link" that only includes the file name in the link, such as 
"moviesl.htm" •• Still, rather than typing the file name by hand, it is best to 
browse and find the page as explained above to avoid making typographical 
errors. 

viii While it is not possible to create the kind of pop-up windows with forms 
suggested by Nagata (1999) in Word or WordPerfect, links that open a new 
window with a definition can be made. Following step 1 above, one could 
make a number of individual web pages with only one definition each, and 
then create links on one of the vocabulary formats by following step 3 above 
(and including step 2(). When clicked on, these links would call up the defini
tion in a separate pop-up window. This is not ideal, as the new windows may 
be rather large for a single definition, and too many such definitions could clut
ter a student's desktop and become distracting. For those without access to spe
cial web design software who wish to include only a few pop-up definitions, 
however, it may be a feasible alternative. 

ix The new Text Annotator, an easy-to-use database and web tool for adding 
pop-up definitions to any text, is another option for instructors wishing to cre
ate glossaries that include text, image, audio and/or video. Created by Judith 
Frommer and Brad Marshall the Text Annotator is available free of charge to 
any educational institution. For more information, please contact the author at 
dbmarsh®fas.harvard.edu. 

x While Word and WordPerfect seem to allow users to "adjust image size", this 
option in fact only changes the appearance of the image on the web page. It 
does not modify the actual size of the image file (such as 40k, 1 MB etc). 
Making a large image look smaller with Word or WordPerfect will not decrease 
the amount of time necessary for users to download the page and image to their 
computer. For those who do not have access to advanced programs such as 
Photoshop or Fireworks, there is a free and easy-to-use program available that 
may be of interest: VCW VicMan's Photo Editor (http://www.vicman.neflvcw
photolindex.htm). Those with certain versions of Microsoft Office can also use 
Microsoft Office Picture Manager. 

xi An image file size of 40k, for example, should take about 5 or 6 seconds to 
load using a dialup modem. 

xii If your course management system does not allow you to upload folders to 
the Internet (as is the case with many free web hosting services), simply create 
an image folder on the web server with the same name (such as 
"moviesl_files" or "moviesl "), transfer the "movies" images one-by-one into 
this folder, and transfer the moviesl.htm web page so that it is next to (not 
inside) the image folder. 

xiii One way to avoid these complexities while maintaining more flexibility in 
text and image placement is to use tables with an image and its corresponding 
text in different cells. 
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APPENDIX I 

LE CINEMA 
EN CONTEXTE 

[Note that the words and expressions to be learned are italicized, 
and often surrounded by reformulations or additional information 

to promote greater understanding.] 

Sarah: J'en ai marre d'etudier! Ce soir je veux sortir! 

Celine: Si on allait au cinema? 
Sarah: D' accord mais a une condition. 

Celine: Laquelle? 

Sarah: On ne va pas voir un film commercial. Ces films americains 
a gros budget, comme "La Guerre des Etoiles'~ je ne les sup
porte pas. 

Celine: Moi, j'ai bien aime « La Guerre des Etoiles ». 

Sarah: Quoi? Ecoute, je ne sais pas qui a ecrit le scenario, mais les 
dialogues etaient nuls! 

Celine: Peut-etre, mais les effets speciaux etaient geniaux- par 
exemple j'ai adore les scenes de combats dans l'espace. 

Sarah: Non, moi je prefere les films d' auteur. Les films ou il y de la 
subtilite, de la finesse. Un film qui fait reflechir, ou on voit 
vraiment Ia personnalite du cineaste - un Truffaut, un 
Hitchcock, un Fellini. 

Celine: Bof. Un film qui fait dormir tu veux dire. 
Sarah: Tu n' es pas drole. Bon, ecoute, allons voir un vieux film 

alors, un dassique comme « Casablanca ». 

Celine: C' est un film en couleurs? 
Sarah: Bien sO.r que non. C' est en nair et blanc. 
Celine: Et qui sont les interpretes? 
Sarah: Quoi? Tu ne sais pas?! Humphrey Bogart et Ingrid 

Bergman! 
Celine: Ah oui, bien sO.r. Deux grands acteurs des annees 60. 
Sarah: Euh, le film est sorti en 1942. 
Celine: Ah bon. 
Sarah: Apparemment, le tournage du film a ete assez difficile. 

Celine: Pourquoi? 

Sarah: Parce que le scenario a ete ecrit au jour le jour, pendant 
qu'ils filmaient, done les acteurs n'avaient pas leur texte 
a l'avance et ne savaient pas comment le film devait se 
terminer! 
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Celine: Interessant. Comment est-ce que tu sais tout cela? 
Sarah: fai vu un documentaire passionnant a Ia tele sur l'histoire 

du film. 
Celine: Et qui a realise le film? 

Sarah: Ah, le realisateur n' est pas tres connu aujourd'hui. 
II s'appelait Michael Curtiz. II a fait beaucoup de films a 
cette epoque. « White Christmas » avec Bing Crosby par 
exemple. 

Celine: Ah, « Noel Blanc », un tres bon film! 

Sarah: Bon, n'exagerons pas.« Noel Blanc »est un film sympa, 
mais « Casablanca »est un vrai chef d'oeuvre. 

Celine: Le film est double j'espere. 

Sarah: Tu plaisantes? Tu crois que je veux entendre une des phrases 
les plus connues du cinema americain en fran~ais? Non, le 
film est en VO, sous-titre en fran~ais. 

Celine: De quelle phrase parles-tu? 

Sarah: "Louis, I think this is the beginning of a beautiful friend
ship:' 

Celine: Qu'est-ce que ~a veut dire? 
Sarah: <;a veut dire "Je crois que ceci est le debut d'une mer

veilleuse amitie." 

Celi.ne: Hmm. Je crois que c'est surtout le debut d'une soiree 
incomprehensible. 

Sarah: Ecoute, tu peux lire les sous-titres situ ne comprends pas les 
dialogues. 

Celine: Bon d'accord. Et il passe dans quel cinema ce film? 

Sarah: Je ne me souviens pas. Tu as le Pariscope ? 
Celine: Non, j'ai achete l'Officiel. Voyons ... Alors ton petit film en 

nair et blanc et en version originale ne passera certainement 
pas dans un des grands multiplexes sur les Champs-Elysees. 

Sarah: Ce n' est pas un "petit film'~ 

Celine: Le voila. II passe dans une salle d'art et d'essai dans le 
quartier Latin - oil il y a aussi un film d' Alfred Hitchcock. 
Alors, il y a une seance de « Casablanca » a 22h , et le film 
commence 10 minutes apres. 

Sarah: Alors, on y va! 
Celine: Oui, let's going! 
Sarah: On dit "Let's go': pas "going". 

Celine: Don't breaking my feet. 
Sarah: Arr~te! Le casse-pieds c'est toi. <;a suffit avec I'anglais. 

On yva. 
Celine: D'accord, on y va. 
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APPENDIX II 

LE CINEMA 
GRAMMATICAL/ ALPHABETIQUE 

[This format is often used by students to review previously studied 
vocabulary, so no explicit definitions have been provided (especial
ly because they are available on the other formats at the click of a 
link). For those unfamiliar with the "Sort, function in Word or 
WordPerfect used to make this format, please see Endnote 2.] 

NOMS 
leila cineaste 
le Pariscope 
le realisateur!la realisatrice 
le scenario 
le tournage 
les effets speciaux 
les sous-titres 
l'Officiel 
un acteur/une actrice 
un chef d'oeuvre 
un documentaire 
un film d' auteur 
un(e) interprete 
un multiplexe 
une salle d'art et d'essai 
une seance 

VERBES 
aller au cinema 
passer : ( un film) passe dans un cinema 
realiser 
sortir : (le film) sort Ia semaine prochaine 

QUALIFICATIFS 
double 
en couleurs 
en noir et blanc 
en VO (version originale) 
sous-titre en ... 
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APPENDIX Ill 

LE CINEMA 
THEMATIQUE 

[Here, vocabulary is grouped in three main themes related to a trip 
to the movies. The reader will notice short sentences, isolated 
words and definitions. 1 

AVANT D'Y ALLER 
Avant d' aller au cinema, on peut consulter le Pariscope ou l'Officiel 
pour choisir un film et connaitre l'heure de Ia seance (le debut de 
Ia projection des publicites et des bandes-annonces avant le film). 

AU CINEMA 
Un film passe dans un cinema - dans un grand multiplex ou dans 
une salle d'art et d'essai (en general plus petit- oil on passe des 
films moins connus). 
Une publicite = « an advertisement », « a commercial » 

Une bande-d'annonce = une publicite pour un film ; « a trailer » 

LE FILM 
Un film d'auteur :par exemple, un film de Fran~ois Truffaut ou de 
Pedro Almodovar. 
Un chef d'oeuvre= un tres bon film 
Un documentaire 
Un film peut etre en couleurs ou en nair et blanc. 
Le scenario est le texte qui contient les dialogues d'un film. 
Le tournage = action de faire un film. 
Les effets speciaux = « special effects » 
Leila cineaste (ou le realisateur/la realisatrice) realise (ou fait) 
unfllm. 
Un acteur/une adrice = un(e) interprete 

Les films qui sortent en France qui sont en VO (en version origi
nale) sont sous-titres en fran~ais. Les personnes qui ne compren
nent pas Ia langue parlee dans le film peuvent lire les sous-titres .. 
Autrement, elles peuvent chercher une version doublee oil les dia
logues ont ete refaits en fran~ais. 
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APPENDIX IV 
ON-LINE DICTIONARIES 

L2-L2 

Spanish-Spanish 
Real Academia Espanola -
http://buscon.rae.es/diccionario/drae.htm 

Portuguese-Portuguese 
Priberam Informatica- http://www.priberam.pt/dlpo/dlpo.aspx 

Italian-Italian 
Garzanti Linguistica - http://www.garzantilinguistica.it/ 

German-German 
Wortschatz Lexicon- http://wortschatz.uni-leipzig.de/ 

French-French 
Le Tresor de la Langue Fran~aise Informatise -
http://atilf.atilf.fr/tlf.htm 

English-English 
Merriam-Webster's Online Dictionary- http://www.m-w.com/net
dict.htm 

The American Heritage Dictionary - http://www.bartleby.com/61/ 

English-12 

English-Spanish 
Diccionarios.com - http://www.diccionarios.com/ 

English-Portuguese 
UOL Biblioteca- http://biblioteca.uol.com.br/ 

English-Italian 
Garzanti Linguistica - http://www.garzantilinguistica.it/ 

English-German 
LEO- http://dict.leo.org/ 

English -French 
WordReference.com - http://fr.wordreference.com/fr/ 
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